
I have a group gitlab site. How should I edit it correctly, beginning with cloning it and committing 
changes. 

ChatGPT said: 

Since you're working on a group GitLab site, you should follow a structured Git workflow to 
avoid conflicts with other contributors. Here’s how you can correctly edit it, starting from 
cloning to committing changes. 

 

1. Clone the Repository 
First, navigate to the directory where you want to clone the project and run: 

sh 
CopyEdit 
git clone <repository_url> 
 

●​ Get the repository URL from your GitLab project by clicking "Clone" and choosing either 
HTTPS or SSH. 

Example:​
sh​
CopyEdit​
git clone https://gitlab.com/your-group/project.git 

●​  

If using SSH:​
sh​
CopyEdit​
git clone git@gitlab.com:your-group/project.git 

●​  

Then, navigate into the directory:​
sh​
CopyEdit​
cd project 

●​  

 



2. Create a New Branch (Recommended) 

To keep things organized, create a new branch instead of directly editing the main branch: 

sh 
CopyEdit 
git checkout -b my-feature-branch 
 

Replace my-feature-branch with a relevant name, such as fix-homepage or 
add-documentation. 

 

3. Make Your Changes 
Now, edit your files using VS Code or any preferred editor. 

If you’re using MkDocs: 

●​ Modify .md files in the docs/ directory. 
●​ Adjust mkdocs.yml for navigation or settings. 

 

4. Stage & Commit Changes 
After editing, check what files were modified: 

sh 
CopyEdit 
git status 
 

To stage all modified files: 

sh 
CopyEdit 
git add . 
 

Or stage specific files: 



sh 
CopyEdit 
git add path/to/file.md 
 

Then commit your changes with a meaningful message: 

sh 
CopyEdit 
git commit -m "Updated homepage with new intro section" 
 

 

5. Push Your Branch to GitLab 
To upload your changes: 

sh 
CopyEdit 
git push origin my-feature-branch 
 

If this is the first push of the new branch, Git will prompt you to set the upstream: 

sh 
CopyEdit 
git push --set-upstream origin my-feature-branch 
 

 

6. Create a Merge Request (MR) 
1.​ Go to your GitLab repository in a browser. 
2.​ Navigate to "Merge Requests". 
3.​ Click "New Merge Request". 
4.​ Select your branch (my-feature-branch) and compare it with main. 
5.​ Add a clear title & description, then submit the MR. 

 

7. Merge & Pull Latest Changes 

Once your MR is approved & merged, switch back to main and pull the latest changes: 



sh 
CopyEdit 
git checkout main 
git pull origin main 
 

 

Optional: Sync Your Branch with main Before Merging 

If there are updates on main while you're working: 

Pull the latest changes:​
sh​
CopyEdit​
git checkout main 
git pull origin main 

1.​  

Merge into your branch:​
sh​
CopyEdit​
git checkout my-feature-branch 
git merge main 

2.​  

If necessary, resolve conflicts, then push:​
sh​
CopyEdit​
git push 

3.​  

 

This workflow ensures clean collaboration and avoids conflicts in your GitLab group project. 
Let me know if you need more details! 🚀 

 
   the instructions are:design, lasercut, and document a parametric construction kit, accounting 
for the lasercutter kerf, which can be assembled in multiple ways, and for extra credit include 
elements that aren't flat 

ChatGPT said: 



That sounds like a great Fab Academy assignment! Here’s how you can approach it: 

1. Design the Parametric Construction Kit 

●​ Choose a Theme: Think of something engaging, like geometric shapes, animals, or 
architectural structures. 

●​ Use Parametric Design: Design your parts in a CAD software that supports parametric 
modeling (Fusion 360, FreeCAD, or OpenSCAD). Use parameters for slot width, tab 
size, and kerf adjustments. 

●​ Account for Kerf: Measure the laser cutter kerf by cutting test pieces and adjusting the 
slot width accordingly. 

2. Lasercut the Pieces 

●​ Material Selection: Use plywood, acrylic, or cardboard. 
●​ Test Fit: Cut a small set first to check tolerances. 
●​ Optimize for Assembly: Ensure slots and connectors allow multiple configurations. 

3. Document the Process 

●​ Screenshots & CAD Files: Include design iterations. 
●​ Kerf Testing Data: Show how you adjusted for laser cutting accuracy. 
●​ Assembly Examples: Photograph different structures made from the kit. 

4. Extra Credit: Non-Flat Elements 

●​ 3D Shapes: Add curved or bent parts using living hinges. 
●​ Interlocking Angles: Use slots that allow angled connections for more complex shapes. 

Do you already have an idea in mind for the shape or theme of your kit? 

4o 

You said: 
I need help with ideas. 

ChatGPT said: 

Got it! Here are some fun and creative ideas for your parametric construction kit: 

1. Geometric Puzzle Kit 

🔹 Concept: Interlocking geometric shapes (triangles, hexagons, pentagons) that can form 
various patterns or 3D structures.​
🔹 Extra Credit: Add curved slots or living hinges to create domes or spheres. 



2. Modular Furniture Kit 

🔹 Concept: Small-scale connectors and panels to create miniature chairs, tables, and shelves.​
🔹 Extra Credit: Use press-fit joints at angles to allow for different configurations. 

3. Animal or Creature Kit 

🔹 Concept: Pieces that assemble into different animals (e.g., a cat, a bird, or a dinosaur) by 
reconfiguring parts.​
🔹 Extra Credit: Add curved pieces or articulated joints for movement. 

4. Miniature City Builder 

🔹 Concept: Modular building blocks that connect to create tiny architectural structures like 
towers, bridges, and houses.​
🔹 Extra Credit: Use different angles and snap-fit joints for 3D complexity. 

5. Spacecraft & Robots 

🔹 Concept: A kit where different wings, bodies, and thrusters can combine to form spaceships 
or robots.​
🔹 Extra Credit: Add movable joints or hinges for articulation. 

6. Letters & Numbers Learning Kit (This could tie into your Fab Academy 
final project!) 

🔹 Concept: Parametric letters or numbers with slots, so kids can connect them like a puzzle.​
🔹 Extra Credit: Add curved elements or interactive parts (like press-fit wheels or hinges). 

7. Wearable Kit 

🔹 Concept: Laser-cut pieces that interlock to form bracelets, necklaces, or even small 
wearable structures.​
🔹 Extra Credit: Use flexible materials or living hinges for a better fit. 

Which of these ideas interests you? Or do you want a mashup of a few? 

4o 

You said: 
Can you give me a diagram? 

ChatGPT said: 



Here’s a rough concept diagram for a parametric construction kit with interlocking shapes. I’ll 
generate an image showing pieces that can connect in multiple ways, with kerf adjustments and 
extra credit elements like curved or 3D parts. One moment! 🎨✨ 

Here's a diagram of a parametric construction kit with interlocking shapes, multiple assembly 
options, and extra elements like curved and angled joints. Let me know if you want 
modifications or additional details! 🚀 

You said: 
Can you provide me with the links of previous fab academy students' websites that successfully 
design a parametric construction kit? 

ChatGPT said: 

 
(not good one)Parametric Construction Kit | Matthew's FabLab ... 
fabacademy.org 

Certainly! Here are some examples of previous Fab Academy students who have successfully 
designed parametric construction kits: 

1.​ Adam Stone's Parametric Construction Kit: Adam designed a kit with two different 
pieces using Cuttle, allowing for various angles when joined.​
 fabacademy.org 

2.​ Richard Shan's Parametric Construction Kit: Richard utilized Fusion 360's parametric 
design features to create a versatile construction kit.​
 fabacademy.org 

3.​ Naim Al-Haj Ali's Molecular Geometry Kit: Naim developed a parametric kit to help 
visualize molecular structures, enhancing hands-on learning in chemistry.​
 fabacademy.org 

4.​ Elaine Regina's Parametric Press-Fit Construction Kit: Elaine explored modular 
patterns and press-fit designs, drawing inspiration from architectural works.​
 fabacademy.org 

5.​ Sara Alsalman's Parametric Construction Kit: Sara designed a press-fit kit in Fusion 
360, allowing for various configurations and easy modifications.​
 fablabbh.fabcloud.io 

These projects showcase diverse approaches to designing parametric construction kits, 
providing valuable insights and inspiration for your own design. 

Sources 

 

 

https://fabacademy.org/2024/labs/chaihuo/students/matthew-yu/docs/parametric_design_2
https://fabacademy.org/2024/labs/chaihuo/students/matthew-yu/docs/parametric_design_2
https://fabacademy.org/2024/labs/chaihuo/students/matthew-yu/docs/parametric_design_2
https://fabacademy.org/2023/labs/charlotte/students/adam-stone/lessons/week3/parametric-construction-kit/?utm_source=chatgpt.com
https://fabacademy.org/2024/labs/charlotte/students/richard-shan/lessons/week3/parametricDesign/?utm_source=chatgpt.com
https://fabacademy.org/2024/labs/techworks/students/naim-alhajali/projects/page2/?utm_source=chatgpt.com
https://fabacademy.org/2024/labs/skylab/students/elaine-regina/assignments/week-03/3-parametric-press-fit/?utm_source=chatgpt.com
https://fablabbh.fabcloud.io/asterisk/2024/sara.zuhair/assignments/week03/?utm_source=chatgpt.com


4o 

You said: 
I am confused about what a parametric construction kit is 

ChatGPT said: 

No worries! A parametric construction kit is a set of interlocking pieces designed using 
parametric modeling, meaning the design can be adjusted easily by changing a few key 
dimensions (like slot width, part size, or angles). These pieces can be assembled in multiple 
ways to form different structures. 

Breaking it Down: 

1.​ Parametric Design 
○​ Instead of manually adjusting every piece, you define variables (like slot width, 

material thickness, and kerf). 
○​ If the material changes or the laser cutter kerf is different, you update one value, 

and all parts adjust automatically. 
○​ Software like Fusion 360, FreeCAD, Grasshopper, or OpenSCAD is often used 

for this. 
2.​ Construction Kit 

○​ The kit consists of multiple laser-cut pieces with slots, tabs, or joints that allow 
them to interlock. 

○​ These pieces can be combined in various ways to create different shapes or 
structures. 

○​ Think of it like LEGO but made from laser-cut materials. 
3.​ Key Features​
✅ Press-fit Joints – Pieces should fit snugly without glue.​
✅ Multiple Configurations – Parts should connect in different ways.​
✅ Kerf Adjustment – Laser cutting removes material, so you compensate for that.​
✅ Flat and Non-Flat Elements (for extra credit) – You can include curved or hinged 
parts. 

Examples of Parametric Construction Kits 

●​ Geometric kits that let you make different polyhedra. 
●​ Modular architecture for building small towers, bridges, or domes. 
●​ Animal or robot kits where different parts snap together. 
●​ Educational kits (letters, numbers, molecules) that help kids learn interactively. 

Would a visual explanation help? I can sketch out a basic example! 🚀 

4o 

You said: 



How could I make an educational parametric construction kit 

ChatGPT said: 

Creating an educational parametric construction kit is a great idea! Here’s a structured 
approach to designing one, tailored for learning: 

 

1. Define the Educational Goal 

First, decide what concept you want to teach: 

●​ 🧩 Alphabet & Numbers – Helps kids learn to form letters and numbers. 
●​ 🔢 Mathematical Shapes – Demonstrates geometric concepts. 
●​ 🔬 Science Models – Molecular structures, physics principles. 
●​ 🌎 Engineering & Architecture – Teaches structural concepts like bridges or domes. 

Since your Fab Academy final project is about helping kids learn letters/numbers, you could 
design a letter-building kit using interlocking parts! 

 

2. Design the Parametric Parts 

Use parametric modeling (Fusion 360, FreeCAD, or OpenSCAD) to create parts that can be 
easily modified. 

For a letter-learning kit, consider:​
✅ Straight and curved segments that can form letters and numbers.​
✅ Slots and press-fit joints for easy assembly.​
✅ Color-coded or engraved guides to show where to connect pieces.​
✅ Optional: Flexible parts (using living hinges) for curved letters. 

 

3. Account for Laser Cutter Kerf 

●​ Cut small test pieces and measure how much material the laser removes. 
●​ Adjust your slot widths so pieces fit snugly. 

 

4. Extra Credit: Non-Flat Elements 

To make the kit even better: 



●​ 🔄 Hinges for Curved Letters (like “S” or “O”) using a flexible pattern. 
●​ 🎭 3D Shapes – Letters can be assembled into blocks for tactile learning. 
●​ 🎨 Interchangeable Pieces – Kids can mix & match to create new shapes. 

 

5. Document Everything 

●​ Screenshots of your CAD model showing parametric features. 
●​ Kerf tests & material experiments to prove fit accuracy. 
●​ Assembly examples with different letters or numbers built from the kit. 

 

Would you like a sketch or diagram to visualize this? 🚀 

4o 

You said: 
yes 

ChatGPT said: 



 

Here's a detailed technical sketch of your educational parametric construction kit for 
teaching letters and numbers. It includes interlocking pieces, curved segments, and living 
hinges for flexibility. Let me know if you want modifications or additional details! 🚀 

You said: 
how to delete a line segment in fusion360 

ChatGPT said: 

To delete a line segment in Fusion 360, follow these methods: 

1. Using the Delete Key 



1.​ Go to the Sketch Mode (if not already in it). 
2.​ Select the line segment you want to delete. 
3.​ Press Delete (⌫ on Mac, Del on Windows) on your keyboard. 

2. Using Right-Click Menu 

1.​ Right-click on the line segment. 
2.​ Click "Delete" from the menu. 

3. Removing Constraints First (If Needed) 

If the line is part of a constraint (e.g., coincident, perpendicular), it may not delete directly. 

1.​ Open the Sketch Palette on the right. 
2.​ Click on the constraint symbol (small icons near the line). 
3.​ Press Delete to remove the constraint first. 
4.​ Now try deleting the line again. 

Let me know if it's not working! 🚀 

4o 

You said: 
i only want to delete part of the line 

ChatGPT said: 

If you only want to delete part of a line in Fusion 360, use the Trim Tool: 

Using the Trim Tool (Recommended) 

1.​ Enter Sketch Mode (double-click your sketch). 
2.​ Click the Modify menu (or right-click) and select Trim (Shortcut: T). 
3.​ Click on the segment of the line you want to remove. 
4.​ Fusion 360 will trim the line at the nearest intersection. 

Alternative: Split the Line First 

If the trim tool doesn’t work as expected: 

1.​ Use the "Split" tool (under the Modify menu). 
2.​ Click the line where you want to cut it. 
3.​ Now select and delete the unwanted segment. 

This keeps the rest of your sketch intact while removing only part of the line. Let me know if you 
need more help! 🚀 



4o 

You said: 
If a sketch is not fully constrained, will I still be able to export it as a .dxf? 

ChatGPT said: 

Yes, you can export a sketch as a .DXF even if it is not fully constrained in Fusion 360. 
However, here’s what you should keep in mind: 

✅ You CAN Export an Unconstrained Sketch 

●​ Fusion 360 does not require sketches to be fully constrained for export. 
●​ You can still save and use the .DXF file for laser cutting or other applications. 

⚠️ Potential Issues with Unconstrained Sketches 

●​ Sketch Might Shift or Scale Incorrectly: If constraints aren’t applied, moving one point 
could distort the entire sketch. 

●​ Inconsistent Slot Sizes: If you're designing a parametric construction kit, unconstrained 
slots could accidentally change size. 

●​ Alignment Issues: If the design lacks fixed points, it may not stay properly aligned when 
imported into another software. 

🔹 Best Practice Before Exporting 

●​ Fix key dimensions to avoid accidental changes. 
●​ Constrain critical features (e.g., slot widths, kerf adjustments). 
●​ Use "Fix" constraints to lock elements in place if needed. 

If you're confident that the sketch won’t change unintentionally, you can go ahead and export it. 
🚀 

4o 

You said: 



 
Why is this not fully constrsined 

ChatGPT said: 

Your sketch is not fully constrained because some elements are still free to move. Here are a 
few possible reasons based on your image: 

1. Unconstrained Arc or Line Segments (Black Lines) 

●​ The two black arcs at the top indicate that these curves are not fully constrained. 
●​ If they were constrained, they would be blue like the rest of the sketch. 

🔹 Fix: Apply constraints such as Coincident, Tangent, or Equal to lock them in place. 

 

2. Missing Dimension Constraints 



●​ If the slots, circles, or curves are not dimensioned, they might still be movable. 
●​ Try adding dimensions (press D for dimension tool) to define: 

○​ The radius of arcs 
○​ The slot widths 
○​ The distance from the center 

 

3. Center Point Might Not Be Fixed 

●​ The central black dot suggests it may be constrained, but check if the outer shape is 
fully locked to it. 

●​ If the entire part shifts when you drag it, try applying a Fix (🔒) constraint or setting a 
Coincident constraint between the center and the origin. 

 

4. Symmetry Constraints Might Be Missing 

●​ If the design is supposed to be radially symmetric, ensure that opposite features are 
constrained with Equal or Symmetry constraints. 

 

How to Find the Issue? 

1.​ Drag different parts of the sketch – anything that moves is not fully constrained. 
2.​ Look at the Sketch Palette (right panel) – If “Degrees of Freedom” is greater than 0, 

something is still unconstrained. 
3.​ Use “Show Constraints” to see which constraints are applied and what might be 

missing. 

Would you like help fixing a specific part? 🚀 

4o 

You said: 



 
not constrained fully 

ChatGPT said: 

Looking at your updated sketch, here are the likely reasons it's still not fully constrained and 
how to fix them: 

Issues & Fixes 

1. The Top Arc (Black Line) is Not Fully Constrained 

●​ The top arc is still black, meaning it can move. 
●​ Fix: Add a Coincident constraint between its endpoints and the main circle's edge. 

 



2. Slots & Inner Details Might Be Free to Move 

●​ The slots and small circles may not be constrained to the center properly. 
●​ Fix: 

○​ Use "Equal" constraints for all identical slots and holes. 
○​ Ensure their distances from the center are dimensioned. 

 

3. Radial Symmetry Might Be Missing 

●​ If the slots and curves should be evenly distributed, make sure you use the "Circular 
Pattern" tool instead of manually placing them. 

●​ Fix: 
○​ Use Circular Pattern (under "Create") to copy constraints to all similar parts. 
○​ Add "Equal" constraints to identical features. 

 

4. Check for Unconstrained Points 

●​ Try dragging different elements—anything that moves is not fully constrained. 
●​ The small white circles at intersections may indicate missing coincident or tangent 

constraints. 

 

How to Quickly Find What's Unconstrained 

1.​ Click on Sketch Palette (right side). 
2.​ Enable "Show Degrees of Freedom" – this will highlight free-moving parts. 
3.​ Drag any point—if it moves, it needs a constraint. 

 

Once all elements turn blue, your sketch is fully constrained! Let me know if any part is still 
unclear. 🚀 

4o 

You said: 
when I use circular pattern the constraints do not copy 

ChatGPT said: 

You're right—Fusion 360's Circular Pattern tool does not automatically copy constraints. 
However, you can manually apply constraints after using the pattern. Here’s how to fix it: 



 

How to Properly Copy Constraints in Circular Patterns 

1. Use the Circular Pattern Correctly 

●​ Select Sketch > Circular Pattern 
●​ Choose the Objects (slots, holes, etc.) 
●​ Select the Center Point (usually the origin or a central circle) 
●​ Set the number of instances 
●​ Click OK 

 

2. Manually Add Constraints After the Pattern 

Since constraints don’t always copy, do the following: 

●​ Use "Equal" constraints 
○​ Select two identical slots or holes → Click Equal 
○​ Repeat for all similar elements 

●​ Use "Coincident" constraints 
○​ Ensure the patterned objects are aligned properly with the base shape 
○​ Select the center of the slots and the main circle → Click Coincident 

●​ Use "Fix" constraints if necessary 
○​ If elements still move, apply a Fix constraint to a key part (e.g., one slot or hole) 

 

3. Try Circular Patterning Entirely Constrained Features 

If possible, fully constrain one slot or hole first, then apply the Circular Pattern to the entire 
set. This often retains constraints better. 

Would you like me to guide you step by step on a specific part? 🚀 

4o 

You said: 
It all constrains until I add fillet 

ChatGPT said: 

When you add a fillet, Fusion 360 sometimes removes constraints because the original 
lines/arcs are replaced by a curved segment. Here’s how to fix it: 

 



Why Does Fillet Break Constraints? 

1.​ Fillet replaces a sharp corner with a curve, so previous constraints (like Coincident or 
Equal) might be removed. 

2.​ If the fillet is applied to a patterned feature, it might not stay identical across copies. 
3.​ The fillet might cause overlapping constraints that Fusion 360 removes. 

 

How to Fix It 

1. Reapply Missing Constraints After Adding Fillet 

●​ If an Equal, Coincident, or Dimension constraint disappears, just add it back: 
○​ Select the filleted edges and apply an Equal constraint if they should match. 
○​ Use Coincident to attach filleted arcs to other lines. 

2. Try Adding Fillet Before Circular Patterning 

●​ Instead of filleting after the Circular Pattern, try this: 
1.​ Fully constrain one slot (including the fillet). 
2.​ Then use Circular Pattern to copy it. 
3.​ Now, everything stays constrained! 

3. Use "Fix" Constraint as a Last Resort 

●​ If small parts still move, you can apply a Fix (🔒) constraint to lock them in place. 

 

What to Try Next? 

🔹 Does the fillet break all constraints, or just some?​
🔹 Would you like help checking a specific area? 

Let me know, and I’ll help you get it fully constrained! 🚀 

4o 

You said: 
The fillet removes the dimensions I have set which consttain the slots 

ChatGPT said: 

Yes! When you add a fillet, it often removes the dimensions that were constraining the slots 
because it replaces the corner with a curve, effectively deleting the points where your original 
constraints were applied. Here’s how to fix it: 



 

How to Keep Slots Constrained After Fillet 

1. Reapply Missing Dimensions After Filleting 

●​ After adding the fillet, check which dimensions got deleted and manually add them 
back: 

○​ If slot width is missing → Use a new dimension (D) to redefine it. 
○​ If slot depth is missing → Dimension from top of slot to bottom again. 

 

2. Try Filleting Before Adding Dimensions 

●​ Instead of dimensioning first and then filleting, try this order: 
1.​ Draw the basic shape of the slot. 
2.​ Apply the fillet first (so Fusion 360 doesn’t remove constraints). 
3.​ Then add dimensions after the fillet is applied. 

 

3. Use Construction Lines to Help Maintain Constraints 

●​ Before filleting, create a construction line inside the slot that marks the center. 
●​ Even if the fillet removes the slot’s original dimensions, the construction line will stay 

constrained. 

 

4. Use "Fix" Constraint as a Backup 

●​ If filleting keeps breaking everything, you can Fix (🔒) one slot in place to stop it from 
moving. 

●​ Then use Equal constraints to make the other slots match. 

 

What Should You Try Next? 

🔹 Are all dimensions removed, or just some?​
🔹 Would you like help with a specific fillet issue? 

Let me know, and I’ll help get everything locked down! 🚀 

4o 



You said: 

 
help me 

ChatGPT said: 

I see your sketch, and it looks like some constraints or dimensions might be missing. Here’s 
what you can check to fully constrain it: 

Steps to Fix It: 

1.​ Check for Unconstrained Points: 
○​ Try dragging parts of the sketch. If anything moves, that part is missing 

constraints. 
○​ Look at the slot cutouts—if they shift when dragged, they might need coincident 

or equal constraints. 
2.​ Fillet Issue (If You're Adding It Later): 

○​ When you apply a fillet, it can remove key dimensions. 



○​ Fix: Add a dimension to the fillet radius and check if it maintains the slot's 
size. 

3.​ Add Symmetry Constraints: 
○​ If the shape is meant to be symmetric, use the midpoint or symmetry constraint 

on mirrored parts. 
○​ The slots should be symmetrical across the vertical axis. 

4.​ Ensure Slot Width & Depth Are Defined: 
○​ The vertical slot (center top) should have both width and depth constrained. 
○​ Add a horizontal dimension to define the width of the angled slots. 

5.​ Look for Unconstrained Angles: 
○​ If any lines are at an angle, they might need an angle constraint. 

 

How to Debug: 

●​ Turn on "Show Degrees of Freedom" (Sketch Palette on the right). 
●​ Anything not locked down (blue) is missing constraints. 
●​ Slowly add constraints one by one and test if it's still unconstrained. 

 

Would you like me to point out specific spots on this sketch? 🚀 

4o 

You said: 
How do I lock the angle? 

ChatGPT said: 

To lock the angle in Fusion 360, use the Angle Constraint. Here's how: 

 

How to Lock an Angle in Fusion 360: 

1.​ Select the Dimension Tool (D on the keyboard). 
2.​ Click on the first line (one of the angled edges). 
3.​ Click on the second line (the horizontal or vertical reference). 
4.​ Move the cursor outward, and you should see an angle dimension appear. 
5.​ Click to place the angle dimension and enter the desired value. 

 

Alternative Ways to Lock the Angle: 



●​ Use the Parallel or Perpendicular Constraint: 
○​ If you want two lines to be at 90°, select both and use the Perpendicular 

constraint. 
○​ If you want two angled edges to stay aligned, use the Parallel constraint. 

●​ Use a Fixed Constraint (🔒): 
○​ If nothing should move, you can Fix one line. 

●​ Use Symmetry Constraint (if applicable): 
○​ If both angled slots should be symmetrical, select the centerline and both slot 

edges, then apply Symmetry. 

 

Check if It's Fully Constrained 

●​ If the sketch is still blue, try dragging it to see what moves. 
●​ If the angle still changes, add a dimension directly to that angle. 

Let me know if you need more help locking a specific part! 🚀 

4o 

You said: 
the angle of the whole shape 

ChatGPT said: 

To lock the angle of the whole shape in Fusion 360, follow these steps: 

1. Fix the Base or Center 

●​ If your shape should be aligned with the horizontal or vertical axis, select a key point 
(like the center of the shape) and apply a coincident constraint to the origin. 

●​ Alternatively, Fix (🔒) one of the base lines if the shape should stay in a specific rotation. 

2. Use a Horizontal/Vertical Constraint 

●​ Select the bottom edge (or another key reference edge) and apply the 
Horizontal/Vertical Constraint (shortcut: H on the keyboard). 

●​ This will prevent the entire shape from rotating. 

3. Add an Angle Dimension 

●​ If your shape should be tilted at a specific angle, use the Dimension Tool (D): 
1.​ Select a reference line (like the X-axis or a horizontal construction line). 
2.​ Select the edge of the shape (whichever defines the rotation). 



3.​ A dimension will appear—set it to the angle you want. 

4. Use Symmetry (If Needed) 

●​ If your shape should be perfectly aligned and mirrored about an axis, apply a 
Symmetry Constraint to key points. 

 

How to Test If It's Fully Locked 

●​ Try dragging the shape: If it rotates, it’s still not fully constrained. 
●​ Look at the Sketch Palette on the right—if it says "Under-Constrained", check for 

missing constraints. 

 

Let me know if you're trying to lock it in a specific way, and I can suggest more targeted fixes! 
🚀 

4o 

You said: 
If I drag the shape and nothign movies but it is still not fully constrained, how to I know what's 
wrong 

ChatGPT said: 

If nothing moves when you drag the shape but Fusion 360 still says the sketch is not fully 
constrained, follow these steps to find the issue: 

 

1. Check for Unconstrained Geometry 

●​ Turn on "Show Degrees of Freedom": 
○​ In the Sketch Palette (right panel), enable "Show Degrees of Freedom" 
○​ This will highlight any unconstrained points with small arrows, showing how they 

can still move. 

 

2. Look for Blue Lines or Points 

●​ Fully constrained sketches turn black. 
●​ If any part of your sketch is still blue, it means it’s missing constraints or dimensions. 



 

3. Try Fixing These Common Issues 

a. Check for Unconstrained Points 

●​ Zoom in and see if there are small open endpoints that are not connected. 
●​ Use the Coincident Constraint (⌘/Ctrl + click two points → "Coincident") to fix gaps. 

b. Check for Floating Geometry 

●​ Sometimes lines or arcs look attached but aren’t. 
●​ Try selecting them and see if they highlight separately. 
●​ If they do, use Coincident or Constrain to Origin. 

c. Check for Missing Horizontal/Vertical or Parallel Constraints 

●​ A shape can look aligned but still be free to rotate slightly. 
●​ Select an edge and apply a Horizontal (H) or Vertical Constraint. 

d. Check for Missing Dimension 

●​ Even if lines look equal, they might be missing a Dimension (D). 
●​ Add dimensions to define exact sizes. 

 

4. Use the "Fix" Constraint as a Last Resort 

●​ If you can’t find the issue, select the whole shape and apply a Fix (🔒) constraint. 
●​ This isn’t the best practice, but it ensures it won’t move. 

 

Final Check: Drag Again 

●​ If everything is constrained properly, the whole shape should stay black and the 
"Under-Constrained" warning should disappear. 

Let me know if you want to send an updated screenshot, and I can help find the exact issue! 🚀 

4o 
 
how to switch to this branch EAAJWeek3 

ChatGPT said: 



To switch to the branch EAAJWeek3 in Git, use the following command in your terminal or VS 
Code terminal: 

bash 
CopyEdit 
git checkout EAAJWeek3 
 

Or, if you're using Git version 2.23 or later, you can use: 

bash 
CopyEdit 
git switch EAAJWeek3 
 

If the branch does not exist locally: 
Fetch all branches:​
bash​
CopyEdit​
git fetch origin 

1.​  

Then switch to it:​
bash​
CopyEdit​
git checkout -b EAAJWeek3 origin/EAAJWeek3 
or​
bash​
CopyEdit​
git switch --track origin/EAAJWeek3 

2.​  

Let me know if you run into any issues! 🚀 

4o 

You said: 
How to commit to a branch? 

ChatGPT said: 

To commit changes to a branch in Git, follow these steps: 



1️⃣ Ensure You're on the Correct Branch 

First, switch to the branch you want to commit to (e.g., EAAJWeek3): 

bash 
CopyEdit 
git checkout EAAJWeek3 
 

or 

bash 
CopyEdit 
git switch EAAJWeek3 
 

2️⃣ Stage Your Changes 

Add specific files: 

bash 
CopyEdit 
git add filename 
 

Or add all changes: 

bash 
CopyEdit 
git add . 
 

3️⃣ Commit Your Changes 

Write a meaningful commit message: 

bash 
CopyEdit 
git commit -m "Your commit message here" 
 

4️⃣ Push the Commit to the Remote Repository 

If the branch is already tracked: 



bash 
CopyEdit 
git push 
 

If it's a new branch that hasn't been pushed before: 

bash 
CopyEdit 
git push --set-upstream origin EAAJWeek3 
 

Let me know if you need more details! 🚀 

 



 
why is it not fully constrained 

ChatGPT said: 

Your sketch is not fully constrained because some degrees of freedom (DOFs) are still left 
undefined. Here are a few possible reasons: 

1.​ Unconstrained Points or Lines: 
○​ Check if any points or edges can still be moved or rotated. 



○​ The bottom edge appears constrained, but the other edges might still have some 
freedom. 

2.​ Missing Dimensional Constraints: 
○​ The overall width and height are constrained, but check if all sections have length 

constraints. 
○​ The slots or cutouts may need additional dimensions to fix their exact positions. 

3.​ Angle Constraints: 
○​ Some angles may not be explicitly constrained. 
○​ The 120° angle is defined, but other angular relationships might still be free. 

4.​ Midpoints or Symmetry Not Defined: 
○​ If the design is meant to be symmetric, ensure that you use a symmetry 

constraint. 
○​ The center slot’s exact placement might be missing a constraint. 

5.​ Constraints on the Internal Features: 
○​ The smaller cutouts and chamfers might not be fully constrained. 
○​ Ensure that all edges of those cutouts have defined dimensions. 

To troubleshoot: 

●​ Try moving different parts of the sketch and see what is still changing. 
●​ Use the "Show Degrees of Freedom" tool in your CAD software to highlight 

unconstrained areas. 
●​ Add missing constraints systematically until everything is fully constrained. 

Would you like to pinpoint the exact issue together? 

4o 

You said: 
The whole hexagon moves together but the curouts move correctly with it 

ChatGPT said: 

If the whole hexagon moves as a unit but the cutouts remain correctly positioned within it, the 
issue is likely that the hexagon itself is not fully constrained to the origin or another fixed 
reference point. Here’s what you can check and fix: 

Possible Issues and Fixes: 

1.​ Missing Fixation to the Origin: 
○​ Ensure that one of the key points (like the center of the hexagon or a vertex) is 

constrained to the origin. 
○​ If the hexagon is meant to be centered, use a coincident constraint between 

the hexagon's center and the origin. 
2.​ Horizontal and Vertical Constraints: 

○​ Check if the hexagon is locked in place by horizontal or vertical constraints. 



○​ If not, use a horizontal or vertical constraint to fix it in place relative to the 
origin. 

3.​ Undefined Overall Position: 
○​ If only the dimensions of the hexagon are defined but its position is not, it can still 

move around freely. 
○​ Try setting a coincident constraint between a key point on the hexagon and an 

axis. 

How to Fix It: 

●​ Try dragging the entire hexagon—if it moves while maintaining its shape, the issue is 
positional. 

●​ Add a coincident constraint between the hexagon's center and the origin. 
●​ Add horizontal/vertical constraints if needed to prevent unwanted movement. 

Once these constraints are added, your sketch should be fully constrained. Let me know if it still 
doesn’t work! 

4o 

You said: 



 
why unconstrained 

ChatGPT said: 

Your hexagon is still unconstrained because its rotation is not fixed. 

Why? 

1.​ The center is constrained, but the hexagon can still rotate 
○​ You have a dimension defining the size (100 mm), which fixes its scale. 
○​ The center is constrained to the origin. 
○​ However, since no angle constraints exist, the hexagon can still spin around its 

center. 

How to Fix It 

To fully constrain the hexagon, you need to lock its rotation by: 



1.​ Adding a Horizontal or Vertical Constraint 
○​ Select one of the hexagon's edges and make it horizontal or vertical. 
○​ This prevents the hexagon from rotating freely. 

2.​ Defining an Angular Constraint 
○​ If you want a specific orientation, add an angle constraint between one of the 

hexagon's edges and a reference axis (X or Y). 

After applying one of these constraints, your sketch should be fully constrained. Try this and let 
me know if it works! 

 
how do I make this parametric? 

ChatGPT said: 



To make this sketch parametric in Fusion 360 (or similar CAD software), follow these steps: 

1. Define Key Parameters 

●​ Open the Modify → Change Parameters menu. 
●​ Add user-defined parameters for key dimensions: 

○​ SideLength = 100 mm (or whatever you need) 
○​ FilletRadius = 2 mm 
○​ HoleDiameter = ? mm (if applicable) 
○​ FeatureSpacing = 30 mm 
○​ FeatureOffset = 10 mm 

2. Apply Constraints and Dimensions 

●​ Use equal constraints to ensure all sides of the hexagon are the same length. 
●​ Use angular constraints to keep angles at 120°. 
●​ Define the positioning of features using parametric dimensions instead of fixed values. 

3. Use Parameters in Dimensions 

●​ Instead of entering fixed numbers, reference the parameters: 
○​ Set the side length using SideLength 
○​ Use FilletRadius for corner rounds 
○​ Use FeatureSpacing and FeatureOffset for hole placements 

4. Fully Constrain the Sketch 

●​ Ensure all dimensions reference parameters. 
●​ Lock down key reference points using horizontal/vertical constraints. 

Once done, you can modify the parameters in Change Parameters, and your design will 
update automatically. Let me know if you need help setting up specific constraints! 

4o 

You said: 
Idk how to fully contrain sketch without using fix 

ChatGPT said: 

Fully constraining a sketch without using the Fix constraint requires a combination of 
dimensions and geometric constraints. Here’s how you can do it step by step in Fusion 360: 

 



1. Start with the Hexagon 

1.​ Draw a Hexagon 
○​ Use the Polygon (Circumscribed or Inscribed) tool. 
○​ Set the number of sides to 6. 
○​ Apply a dimension to set the side length (use a parameter like SideLength if 

making it parametric). 
○​ Use a horizontal constraint to align one edge with the horizontal axis. 

2.​ Ensure Equilateral Sides 
○​ If drawn manually, apply Equal constraints to all six sides. 

3.​ Constrain Position 
○​ Use a coincident constraint to place the center of the hexagon at the origin 

(0,0). 
○​ This removes unnecessary movement. 

 

2. Constrain Additional Features 

For any holes, fillets, or cutouts: 

1.​ Holes & Cutouts 
○​ Use Horizontal/Vertical constraints to align features. 
○​ Dimension distances using parameters like FeatureSpacing and 

FeatureOffset. 
○​ Use Equal constraints for identical holes/cutouts. 

2.​ Fillets 
○​ Instead of manually fixing, apply a Fillet feature and set a parametric radius 

(FilletRadius). 
3.​ Rectangles or Slots 

○​ If features like rectangles are included, constrain: 
■​ Width and height using parametric dimensions. 
■​ Center position using midpoint constraints or horizontal/vertical 

dimensions. 

 

3. Check if Fully Constrained 

●​ If everything is properly constrained, Fusion 360 will show the sketch lines in black. 
●​ If there are blue lines, something is still underdefined—click on a blue edge to see how 

it moves and apply the necessary constraints. 

Would you like me to guide you through debugging any specific part of your sketch? 😊 



4o 

You said: 
What if there are no blue lines? 

ChatGPT said: 

If there are no blue lines in your Fusion 360 sketch, but it’s still not fully constrained, here are a 
few things to check: 

1. Check for Degrees of Freedom 

●​ Try clicking and dragging different parts of the sketch. If anything moves, it's not fully 
constrained. 

●​ If nothing moves and everything is black, then your sketch is fully constrained—you’re 
good to go! 

2. Verify Constraints 

●​ Look for missing constraints: Sometimes Fusion 360 automatically applies 
constraints, but it’s good to double-check: 

○​ Use Equal constraints for identical features. 
○​ Ensure all coincident constraints are applied where needed. 
○​ Use Horizontal/Vertical constraints to align important edges. 

●​ If needed, use the Show Degrees of Freedom tool (in Sketch → Sketch Diagnostics) to 
see what might still be moving. 

3. Check Redundant Constraints 

●​ If you’ve added too many constraints, Fusion 360 might over-constrain the sketch, 
which can cause issues. 

●​ If you see a warning symbol, hover over it—Fusion 360 will tell you if a constraint is 
unnecessary. 

4. Look for Unconstrained Features 

●​ Sometimes small details, like fillets or construction lines, are left unconstrained. 
●​ Make sure all dimensions use parameters where needed. 

If everything is black and doesn’t move when dragged, your sketch is fully constrained! 🚀 Let 
me know if you need help troubleshooting anything specific. 
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